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Programma
1) Visuele stuurhulp met RTK-gps-ontvanger en AgOpenGPS

>21/1

2) Autostuur met arduino-module, stuurhoeksensor en stuurmotor

>28/1
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Stuurhulp - waarom?
manueel sturen <15 cm (met oefening)

overlap vermijden

‘doorsteken’ in een veld

draaien zonder keren op kopakker igv smalle werktuigen, zie vb. 

sectiecontrole

??aanhouden rijpaden??

...
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1 overslaan

2 overslaan

3

2

Draaien zonder keren vb.
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plaatselijke combinaties ifv in- en uitzetten

3
3

3

3
3

3
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Programma - stuurhulp met RTK en AgOpenGPS
principe, benodigdheden

setup GPS-ontvanger met ublox center software

setup met hotspot, connecties, ntrip (RTK maken)

demo programma AgOpenGPS

opbouw tractor, accessoires, mogelijke uitbreidingen

8



Satellietnavigatie - GNSS
bv. GPS, GLONASS, GALILEO, …

tijd die signaal aflegt tot ontvanger
= afstand tot satelliet

verstoringen signaal door de lokale luchtlagen 
= foutmarge op positie (meters)

9http://www.reflexions.uliege.be/cms
/c_358355/en/the-erroneous-gps-si
gnal

https://nl.wikipedia.org/wiki/Satelliet
navigatie

http://www.reflexions.uliege.be/cms/c_358355/en/the-erroneous-gps-signal
http://www.reflexions.uliege.be/cms/c_358355/en/the-erroneous-gps-signal
http://www.reflexions.uliege.be/cms/c_358355/en/the-erroneous-gps-signal
https://nl.wikipedia.org/wiki/Satellietnavigatie
https://nl.wikipedia.org/wiki/Satellietnavigatie


Real Time Kinetic GNSS

https://www.researchgate.net/publication/237370722_AN_INTRODUCTION_-_
GLOBAL_POSITIONING_SYSTEM
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 vast basisstation in dezelfde lokale luchtlaag 

https://www.researchgate.net/publication/237370722_AN_INTRODUCTION_-_GLOBAL_POSITIONING_SYSTEM
https://www.researchgate.net/publication/237370722_AN_INTRODUCTION_-_GLOBAL_POSITIONING_SYSTEM


‘Correctiegegevens’ RTK
informatiestroom van basisstation naar ‘rover’

overdracht via radio, mobiel internet, …

volgens een zgn. ‘NTRIP’-protocol

Vlaanderen biedt gratis NTRIP-service (FLEPOS-netwerk)

Registreren via: 
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https://overheid.vlaanderen.be/registratie-flepos-30-dienstverlening

https://overheid.vlaanderen.be/registratie-flepos-30-dienstverlening


FLEPOS 3.0 basisstations

https://overheid.vlaanderen.be/flepos-30-ondersteuning 12

https://overheid.vlaanderen.be/flepos-30-ondersteuning


RTK-precisie
stijgt met:

aantal satellieten in beeld
nabijheid basisstation (<20 km)

GPS: meters fout

DGPS: fout is kleiner dan ‘single’ GPS

FLOAT: fout < 1m en vaak < 10 cm

FIX: fout < 2 cm
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RTK-fix bereiken/behouden
probleem: 

obstructies en reflecties van signalen in de omgeving: ‘multipath effects’

door stoorfactoren in de omgeving: 
beton, metaal,
objecten met water: bomen,
…

14https://www.researchgate.net/public
ation/312542985_Fisheye-Based_
Method_for_GPS_Localization_Imp
rovement_in_Unknown_Semi-Obstr
ucted_Areas

https://www.researchgate.net/publication/312542985_Fisheye-Based_Method_for_GPS_Localization_Improvement_in_Unknown_Semi-Obstructed_Areas
https://www.researchgate.net/publication/312542985_Fisheye-Based_Method_for_GPS_Localization_Improvement_in_Unknown_Semi-Obstructed_Areas
https://www.researchgate.net/publication/312542985_Fisheye-Based_Method_for_GPS_Localization_Improvement_in_Unknown_Semi-Obstructed_Areas
https://www.researchgate.net/publication/312542985_Fisheye-Based_Method_for_GPS_Localization_Improvement_in_Unknown_Semi-Obstructed_Areas
https://www.researchgate.net/publication/312542985_Fisheye-Based_Method_for_GPS_Localization_Improvement_in_Unknown_Semi-Obstructed_Areas


‘Multi-band RTK’
ontvangst signalen op 2 banden filtert o.a. reflecties

voordelen: snelle en zeer stabiele fix

GNSS-ontvangers nu sowieso met alle constellaties

maar budget-opties tot voor kort enkel via L1-band

multi-band L1/L2 voor de massa sinds 2019
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Nieuwe L1/L2 opties dankzij u-blox F9P-chip

Van printplaatje tot gebruiksklaar 

Meest basic versies, kunnen al het essentiële:

RTK-gps-ontvangers 2019

https://www.ardusimple.com

https://emlid.com

https://www.csgshop.com/product.php?id_product=263
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https://www.ardusimple.com
https://emlid.com
https://www.csgshop.com/product.php?id_product=263


simpleRTK2B + multiband antenne (ardusimple)
module met u-blox F9P-chip L1/L2

micro-USB voor stroom en communicatie

SMA-connector voor antenne (5m)

incl. antenne, verzending, btw  +- 280 euro

optie ‘headers soldered’ normaal niet nodig

USB naar micro-USB datakabel niet bijgeleverd

eenmalige procedure om in te stellen voor AOG
17

https://www.ardusimple.com/produc
t/simplertk2b-basic-starter-kit-ip65/

https://www.ardusimple.com/product/simplertk2b-basic-starter-kit-ip65/
https://www.ardusimple.com/product/simplertk2b-basic-starter-kit-ip65/


AgOpenGPS / AOG
open source software-project door o.a. Brian Tischler (VS)

enkel op Windows

sinds 2019 eenvoudige integratie met GPS-ontvanger: AOG stuurt 
correctiegegevens door naar ontvanger, krijgt RTK-positie terug

management voertuigen, percelen, navigatielijnen, kopakkers, …

visuele hulp of samen met autosteer

constant in evolutie (let op met nieuwe versies, soms geen weg terug)
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AgOpenGPS
code, download laatste versie:
https://github.com/farmerbriantee/AgOpenGPS 

ontwikkeling, discussie:
https://agopengps.discourse.group

demo van de software, nieuwe functies: 
https://www.youtube.com/user/FarmerBrianTee/videos

telegram discussiegroep ontwikkelaars:
https://t.me/agopengpsinternational 

starters-wiki (verouderd!): 
http://agopengps.gh-ortner.com/doku.php?id=start

20

https://github.com/farmerbriantee/AgOpenGPS
https://agopengps.discourse.group
https://www.youtube.com/user/FarmerBrianTee/videos
https://t.me/agopengpsinternational
http://agopengps.gh-ortner.com/doku.php?id=start


Overzicht setup

Tablet met 
AgOpenGPS

Flepos via internet

Smart-
phone 
hot-
spot

antenne op de 
neus v/d tractor
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Setup hotspot en verbinding tablet
Smartphone > wifi > hotspot instellingen: naam en wachtwoord

Tablet > wifi netwerk verbinden: wachtwoord invullen

bij windows instellingen > netwerk > … : ‘netwerk met verbindingskosten’ of 
‘verbinding met datalimiet’ aanvinken

zie tutorials bv.
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http://www.youtube.com/watch?v=it5979Six1s


ter info: 2 micro-usb poorten

power + enkel power
communicatie

23



ter info: COM-poorten
Start/windows knop > Apparaatbeheer > Poorten (COM & LPT) > …

Plug USB-toestel in/uit > COM-poort verschijnt/verdwijnt

Onthoud nummer COM … 

In ucenter / AgOpenGPS:
COM … selecteren

Slechts 1 programma tegelijk kan COM-poort gebruiken. Na setup in ucenter, 
ucenter afsluiten vooraleer AgOpenGPS te openen.
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Setup simpleRTK2B snelle manier (1)
download 2 bestanden in deze procedure (te vinden bij stap 2 en 3): 
https://agopengps.discourse.group/t/ublox-f9p-config-for-rover/308

download ‘u-center for windows’, installeer: 
https://www.u-blox.com/de/product/u-center

sluit module aan, open programma. Evt. COM-poort kiezen 
OK als onderaan groene connectie bv. ‘COM 9600’ te zien is.

eerst Tools > Firmware update. Kies bij Firmware image (...) het gedownloade .bin 
bestand in Downloads-map. Linksonder groene bol ‘Go’ klikken, wachten tot alles 
groen.

dan Tools > Receiver configuration. Kies bij Configuration file (...) de gedownloade 
.txt in Downloads-map. Klik ‘Transfer file -> GNSS’ 25

https://agopengps.discourse.group/t/ublox-f9p-config-for-rover/308
https://www.u-blox.com/de/product/u-center


Laatste stap: alle wijzigingen opslaan:

Belangrijk: bij 5 en 6 geen fouten maken:

1. View > Messages view
2. Scroll linkse tabel naar beneden, dubbelklik UBX
3. In uitklappende lijst, dubbelklik CFG (Config)
4. In uitklappende lijst, klik CFG
5. In rechtsboven kader ‘Devices’ alles selecteren
6. Linksonder ‘Send’ klikken
7. Rechtsboven verschijnt teller sinds laatste ‘Send’: dan OK.

26

Setup simpleRTK2B snelle manier (2)



(Setup simpleRTK2B manueel)
via u-center software https://www.u-blox.com/en/product/u-center

view > messages view > UBX > CFG > PRT/RATE

baud rate 115200 (communicatiesnelheid over USB-poort)

update rate 125 ms - 8Hz (maximum bij gebruik van alle constellaties)

telkens na wijziging ‘Send’ onder links

nadien UBX > CFG > CFG > selecteer alle devices > Send (geen fouten maken)
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AgOpenGPS logica
1. Setup GPS.

Eerste keer starten: GPS-simulator aan (uittesten programma)
Locatie-bron aansluiten, herstart met simulator uit. Pas verder indien GPS

2. Setup stuurhulp.
Voertuig-vehicle
+ Werktuig-implement
+ Perceel-field 
+ AB-lijn. Pas dan alle functies voor stuurhulp en autostuur beschikbaar

3. Autostuur
Arduino voor autostuur aansluiten
Instellingen autostuur doorlopen
Autosteer-knop aanzetten

28



ter info: simulator en GPS conflict oplossen
1 van deze 2 is de locatiebron naar keuze. Kan niet tegelijk

in zeldzame gevallen bij wisselen tussen de 2 ontstaat een conflict in geografische 
UTM-zone en schiet het scherm alle kanten op, zowel bij simulator als bij GPS.

oplossing is volgende. 

1. Sluit Agopengps.
2. Open in verkenner de map > Lokale schijf (C:) > Gebruikers > gebruikersnaam
3. Bovenaan in verkenner, ga naar beeld en vink aan ‘Verborgen items’
4. Open de map AppData > Local. 
5. Daar zie je de map ‘AgOpenGPS’: deze verwijderen.
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30

overzicht basisscherm 
(v4!)



● 1 - 5Hz: GPS update rate, 3: Frame build time in ms, Sim: simulator mode “ON”
● 2 - Day\Night mode switch
● 3 - full screen mode
● 4 - zoom
● 5 - Exit
● 6 - GPS speed
● 7 - Tram Lines
● 8 -
● 9 - Edit AB-line
● 10 - AB-curve dialog
● 11 - 
● 12 -
● 13 - Choose AB-line or curve, based on Boundary points
● 14 - AB-line dialog
● 15 - Headland On\Off
● 16 - Section control, manual mode
● 17 - 
● 18 - Section control, automatic mode
● 19 - Place a flag 
● 20 - U-turn enable
● 21 - Auto\Manual steering mode
● 22 -
● 23 - zoom modes
● 24 - GPS data dialog
● 25 - 
● 26 - Tool configuration dialog
● 27 - Machine configuration dialog
● 28 - Setup (UDP, NTRIP, Serial ports, Heading/Roll, etc.)
●

31

● 28 - Setup (UDP, NTRIP, Serial ports, Heading/Roll, etc.)
● 29 - 
● 30 - New Field dialog, you can create new or make a clone from existing 

one
● 31 - Headland & Boundary
● 32 - Snap left (value is set in MACHINE→GUIDANCE→ “«» Snap 

distance” )
● 33 - Snap right 
● 43 - displays: “Tool_width Machine_name - Tool_name -”
● 44 - Sections status. Red - off, Yellow - manually on, Green - automatic 

mode
● 45 - swap direction in simulator
● 46 - simulator speed
● 47 - stop moving
● 48 - steering control during simulation
● 49 - set steering to zero
● 50 - Resets the simulator
● 51 - machine and tool
● 52 - show\hide extended mode
● 53 - GPS data, left bar
● 54 - Tree planter, WebCam, GPS shift, G.Earth flags dialog)
● 55 - View position setup
● 56 - 2D\3D mode
● 57 - UDP port load 
● 58 - 
● 59..61 - menu



1. Setup GPS in AgOpenGPS (in afwachting van v4)
sluit u-center. download, open: https://github.com/farmerbriantee/AgOpenGPS/releases

installeren: zie ook https://www.youtube.com/watch?v=4V2yClw5AH4  

Linksboven platte streepjes of venster: eventueel lokale sim.coörd. invullen, bv. 51 
en 3. Eventueel taal aanpassen. Simulator uit

Serial ports > GPS port > COM v/d USB-poort, 115200, 8Hz, Connect

NTRIP > instellingen Flepos invullen:
IP, poort 2101, mount FLEPOSVRS32GREC, gebruikersnaam, wachtwoord, 
use GPS fix, NTRIP On

Tussenin problemen? Sluit en herstart programma. Evt. andere USB-datakabel 
32

https://github.com/farmerbriantee/AgOpenGPS/releases
https://www.youtube.com/watch?v=4V2yClw5AH4
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2. Setup stuurhulp: voertuig, werktuig 
Vehicle: dimensies, plaats GPS-antenne, …

Implement

bv. v4 werktuig apart:
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http://www.youtube.com/watch?v=sHVZWQocnT0


2. Setup stuurhulp: perceel, grenzen
Field: openen bestaand veld, nieuw creëren

Boundary: perceelgrenzen eenmalig rijden / importeren van KML (Google Earth)
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ter info: KML
format voor geografische lijnen of oppervlaktes

opslaan vanuit bv. QGIS, zie: 
https://agopengps.discourse.group/t/repeated-crashing-when-loading-kml-file/877/
15 

andere tools om te maken, bv. CSV naar KML:

https://kmltools.appspot.com/

36

https://agopengps.discourse.group/t/repeated-crashing-when-loading-kml-file/877/15
https://agopengps.discourse.group/t/repeated-crashing-when-loading-kml-file/877/15
https://kmltools.appspot.com/


ter info: Google Earth Pro
gratis tool https://www.google.com/intl/nl/earth/versions/ 

.kml met perceelgrens maken om in te lezen in AgOpenGPS (fout snel 2m!)
of

.kml in de fields-map van AgOpenGPS openen met Google Earth (vanaf v4)

tutorials, bv. 

beste optie voor aanmaak perceelgrenzen blijft zelf inrijden/afstappen: in v4 
makkelijk

37

https://www.google.com/intl/nl/earth/versions/
http://www.youtube.com/watch?v=U4-w-w2BFjY


2. Setup stuurhulp: AB-lijnen 
AB-knop: selecteren
hand-knop: AB-lijnen of curvelijnen aanmaken adhv

 perceelgrenzen en opslaan

< en > pijlen: navigatielijn wat opschuiven

blokjes en cijfer bovenaan: indicatie afwijking van navigatielijn

38

http://www.youtube.com/watch?v=HPKyj1lL3Yc


AgOpenGPS v4
jan/feb 2020?

wacht op deze versie voor:
definitief aanmaken van voertuigen (tractor en werktuig vanaf v4 gescheiden)
inrijden, afstappen van perceelgrenzen (AOG zal zelf KML aanmaken in de 

programmamap bij ‘Fields’)

belangrijkste setup kan je al doen met v3.09

kijk terug naar github voor release of volg youtube-kanaal Brian voor nieuwe 
functies v4:

39

http://www.youtube.com/watch?v=AHIL8usD4v8


Opbouw tractor
tip: begin heel eenvoudig

antenne op motorkap (=grote grondplaat)
kabel langs deur naar binnen
oude laptop/… om mee te beginnen
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Antenne opbouw
belangrijk: grondplaatje 10-12 cm glad alu/inox 

zo ver mogelijk naar voor? (indien autostuur later)

niet per se hoog

maar ook niet teveel obstructie door motor/cabine

kabel niet gelijkleggen met grote stroomkabels

opletten met gevoelige SMA-connector

41



Tablet
Windows (7), 8 of 10 (RT), tenminste 1 USB-poort die geen laadpoort is

beveiligingsmodus uitschakelen om extern programma te kunnen installeren

Resolutie min. 1366x768, liever 1920x1080 (Full HD) of meer

Schermgrootte gelijk, tablethouders meestal tot 11”, max 12,2”

Scherm glans, helderheid naargelang omgeving (hoge ‘nits’ of ‘cd/m2’)

Prestaties: min. (2 of) 4GB RAM, i3 processor (alles > 2016?), opslag mag klein zijn

Robuustheid? Normaal gebruik geen vrees. Anders o.a. ‘toughbooks’:

Bv: https://agopengps.discourse.group/t/toughpad-book/399
42

https://agopengps.discourse.group/t/toughpad-book/399


bv. 10” Asus Transformer T100 (oud, prestaties nipt)
10” Microsoft Surface Go 4GB (USB-C hub nodig, ofwel via Bluetooth)

43

https://www.bol.com/nl/p/hyper-usb-c-hub-for-surface-go/9200000101807636/?country=BE
https://www.coolblue.be/nl/product/798356/satechi-slim-type-c-multiport-adapter-grijs.html

https://www.bol.com/nl/p/hyper-usb-c-hub-for-surface-go/9200000101807636/?country=BE
https://www.coolblue.be/nl/product/798356/satechi-slim-type-c-multiport-adapter-grijs.html?cmt=c_a%2Ccp_2070956551%2Ca_76647415855%2Ct_pla-794158075653%2Cn_g%2Cd_c&gclid=Cj0KCQiAjfvwBRCkARIsAIqSWlN335lTqteGnh5KFRC2Uw4paYLWZ0xXkFQBHb4IvcDQkOk63AHcV3gaAvXgEALw_wcB
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https://www.ardusimple.com/produc
t/bluetooth-module/

Zelf geen ervaring mee, nog uit te zoeken!

SimpleRTK2b zal manueel anders ingesteld moeten worden in ucenter.
Module moet op zelfde snelheid communiceren als simpleRTK2b en Agopengps 
(115200!)

Mogelijk bieden ze bij ardusimple de simpleRTK2b en bluetooth module op vraag 
samen aan met de gewenste configuratie.

Kies voor USB of USB-hub voor zekerheid en gemakkelijkheid.

https://www.ardusimple.com/product/bluetooth-module/
https://www.ardusimple.com/product/bluetooth-module/


bv. alternatief: pc/laptop met apart touch display (duur)

45https://agopengps.discourse.group/t
/computer-to-run-agopengps/659/

https://agopengps.discourse.group/t/computer-to-run-agopengps/659/4
https://agopengps.discourse.group/t/computer-to-run-agopengps/659/4


ter info: remote monitor software

( https://www.teamviewer.com/ ) - scherm overnemen op afstand (internet) 

https://spacedesk.net  - scherm overnemen via lokaal netwerk (hotspot, USB)

verlegt windows-scherm naar elk ander toestel (smartphone, android tablet, ipad, …)

bv. screenshot op smartphone:

46

https://www.teamviewer.com/
https://spacedesk.net


ter info: instellingen gesloten klep (laptop, tablet, …)
om windows te laten draaien met gesloten toestel (bij verlegd scherm)

windows > energiebeheerschema > geavanceerde instellingen

procedure zie 
https://www.coolblue.be/nl/advies/instellingen-laptop-klep-wijzigen-windows-10.ht
ml 

47

https://www.coolblue.be/nl/advies/instellingen-laptop-klep-wijzigen-windows-10.html
https://www.coolblue.be/nl/advies/instellingen-laptop-klep-wijzigen-windows-10.html


Accessoires
Lader tablet: stevig 3A exemplaar nodig, 2A volstaat meestal niet

Beugel voor tablet: zuignap of veiliger met klem

Behuizing GPS-ontvanger: kan eenvoudig, wel stevig vast maken

https://www.thingiverse.com/thing:3551604
48

https://www.thingiverse.com/thing:3551604


vb. (ook lokaal te vinden)
https://www.gsmpunt.nl/opladers/baseus-dubbele-usb-fast-charge-autolader-zwart

https://www.coolblue.be/nl/product/758841/caliber-cnc16-universele-tablethouder.
html

https://www.conrad.be/p/tru-components-92022c00215-universele-behuizing-115-
x-90-x-55-abs-lichtgrijs-1-stuks-1662364

zie volgende workshop
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https://www.gsmpunt.nl/opladers/baseus-dubbele-usb-fast-charge-autolader-zwart
https://www.coolblue.be/nl/product/758841/caliber-cnc16-universele-tablethouder.html
https://www.coolblue.be/nl/product/758841/caliber-cnc16-universele-tablethouder.html
https://www.conrad.be/p/tru-components-92022c00215-universele-behuizing-115-x-90-x-55-abs-lichtgrijs-1-stuks-1662364
https://www.conrad.be/p/tru-components-92022c00215-universele-behuizing-115-x-90-x-55-abs-lichtgrijs-1-stuks-1662364


ter info: zwakke schakels in dit systeem
zelf ondervinden… de kanshebbers zijn:

vroeger: de ontvanger
nu met L1/L2 slechts uitzonderlijk wegvallen van RTK fix (onder obstructies)
herplaats antenne met meer vrij zicht, probeer vooraleer je definitief monteert

smartphone of tablet met netwerkkaartje
stabiliteit verbinding afhankelijk van 

drukte op mobiel netwerk, kwaliteit interne antenne en eigenzinnig toestel
heroppikken netwerk soms te traag. >30s: fix valt weg.

connecties
Bluetooth mogelijk niet waterdicht. USB: normaal geen probleem.
UDP/ethernet nog beter (herconnecteert zonder pauze) - voor de moedigen 50



Uitbreidingen

Voorkomen wegvallen van fix door netwerkonderbrekingen (bv. autostuur!)
professionele router met aparte SIM, bv. Teltonika RUT955
normaal voldoende. met tweede back-up SIM volledig waterdicht

‘Work switch’, bv. schakelaar t.h.v. hefinrichting (arduino, zie volgende keer)

Hellingscorrectie, hoewel weinig nut bij enkel glooiing (via arduino)

Communicatie bluetooth/wifi/ethernet ipv USB
bv. HC-05 module https://www.ardusimple.com/product/bluetooth-module/
let wel: voor autostuur en arduino usb nodig, tenzij ook bluetooth (moeilijker)
> zie volgende keer

51

https://www.ardusimple.com/product/bluetooth-module/


Uitbreidingen
bv. voor de moedigen: externe ‘lightbar’:

https://twitter.com/mnlt18/status/1218865524437745664

https://agopengps.discourse.group/t/external-light-bar/830

52

https://twitter.com/mnlt18/status/1218865524437745664
https://agopengps.discourse.group/t/external-light-bar/830


Boodschappenlijst visuele stuurhulp
Essentieel:

simpleRTK2B + antenne 280
windows tablet 300-500*
flepos-abonnement 0

totaal 600-... euro

Optie / al aanwezig?

router RUT955 250
smartphone 100-...
data-abonnement 10/md-...
tablethouder 15-...
lange USB-kabel 10-...
bluetooth-module 5-35
...

*tip: tweedehands 53



Deel 2 - autostuur
> 28/1

54



Autostuur - waarom?
(streven naar) rechte lijnen en perfecte aansluiting

precisiewerk dat RTK-niveau +- 2cm benadert: zaaien, planten, ...

handen en ogen vrij voor wat belangrijk is

rijpaden precies aanhouden

‘blinde’ bewerkingen mogelijk bv. 2x wiedeg vooropkomst
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Autostuur - waarom niet?
GPS-zaaien en dan GPS-schoffelen: kan niet op deze manier

risico’s: gedachten er niet bijhouden of geen chauffeur, zonder veiligheden = zeer 
gevaarlijk!

aansprakelijkheid

tijd en interesse: concept en zelfbouw niet heel eenvoudig, leercurve 
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Alternatieven lage-kost autostuur
Cerea GPS: ook autosteer, niet met AOG https://www.cereagps.com

eFarmer - Fieldbee https://www.fieldbee.com

Agribus-navi android app https://agri-info-design.com/en/agribus-navi/ 

RTK autosteer via smartphone, zonder tablet of AOG door Matthijs Missiaen 
https://www.youtube.com/watch?v=CU07_27NSQg 

Farmtek obv AgOpenGPS, binnenkort? https://www.farmtek.fr 

…?
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Overwegingen autostuur
lage kost alternatieven…

… ⇔ gangbare aanbieders (Raven, Trimble, …) 
prijsverschil groot, maar service? veiligheid, aansprakelijkheid?
weldra concurrentiëler?

… ⇔ zelfbouw
op eigen risico, kost, verdienste
volledig af te raden
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https://www.youtube.com/watch?v=EPSXxna0qCg60

http://www.youtube.com/watch?v=EPSXxna0qCg
https://www.youtube.com/watch?v=EPSXxna0qCg


Zaaicombi 4 à 5 km/u Plantmachine 0,6 km/u
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Autostuur - programma
principe, benodigdheden

setup Arduino

setup printplaat, modules, connecties, ...

rondleiding AOG autosteer

opbouw tractor

accessoires, mogelijke uitbreidingen
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Principe
nieuwe figuur in het spel: Arduino nano/uno

microprocessor-module voor DIY elektronica

met pc-programma voor schrijven en uploaden van code

open source community met veel code-vb. en toebehoren

rol bij autostuur: centrale spil tussen tablet, sensoren, modules, motor, ...
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Overzicht

Tablet met 
AgOpenGPS

Flepos via internet

Smart-
phone 
hot-
spot

antenne op de 
neus v/d tractor

...

...
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Principe autostuur
drietal informatiebronnen:

1. positie: waar is een bepaald punt van het voertuig?

AOG verwerkt posities, eventueel met hellingscorrectie v Arduino.

2. stuurhoek: hoe staan de voorwielen?
3. richting: in welke richting staat het voertuig?

Arduino verwerkt data, naar AOG.
algoritme in AOG berekent de ideale stuurhoek, naar Arduino.
Arduino berekent de ideale draai aan het stuur, naar de motor/ventiel.
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https://publicdomainvectors.org/en/f
ree-clipart/Tractor---tillage-and-plan
ting/35781.html
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1. Positie GPS

meer naar achter, boven achteras = richting o.b.v. GPS-posities is stabieler

meer naar voor = afwijking van de lijn wordt snel opgepikt

elk algoritme gaat er anders mee om

compromis voor precisiewerk: ergens boven vooras?  + ‘Stanley’ algoritme

A Simple Method to Improve Autonomous GPS Positioning for 
...https://www.mdpi.com › pdf
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1. Positie GPS - hellingscorrectie ‘roll’
op hellingen >5° de moeite waard, anders enkel ruisfactor

module ‘MMA8452’ (GY45) of ‘MMA8452Q’ (Sparkfun)
 eenvoudige aansluiting met Arduino, mogelijk wel solderen

op juiste manier oriënteren: helling ‘roll’ links is +, rechts is -
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2. Stuurhoek ‘steer angle’
‘WAS’ wheel angle sensor ter hoogte van stuuras

sterke GND (- aarding) en +5V (5 volt) nodig voor stabiel signaal

signaal tussen 0V en 5V naar ‘ADS 1115 module’ (solderen)

ADS leest signaal in met hoge resolutie, naar Arduino

Arduino zet om naar stuurhoek ‘counts’ / aantal (- is links, + is rechts)

http://gh-ortner.com/agopengps/doku.php?id=steering_angle_sensor:start
https://agopengps.discourse.group/t/steering-angle-sensors/123
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http://gh-ortner.com/agopengps/doku.php?id=steering_angle_sensor:start
https://agopengps.discourse.group/t/steering-angle-sensors/123


AgOpenGPS: bepaalt richting op basis van GPS-posities van laatste 1 à 2 m

Nadelen: antenne op de neus ‘waggelt’, onder 1 km/u slechte werking

Arduino: eventueel toevoeging van kompas-module bv. BNO055 (solderen), Brick

Nadelen: geen absolute richting, drift, gevoelig voor metalen

Oplossing: AgOpenGPS ‘versmelt’ richting uit deze 2 bronnen tot min of meer 
stabiele richting

Advies: deze component weglaten = minder complex, gebruik ‘Stanley’ algoritme

3. Richting ‘heading’
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Oplossing in zicht...

‘dual GPS autosteer’ cfr. AgLeader e.a.

levert sublieme positie, helling, richting

u-blox chips met ingebouwde functionaliteit

nog geen implementatie in AgOpenGPS

in ontwikkeling: https://github.com/mtz8302/AOG_Dual_GPS 

https://www.youtube.com/watch?v=AKdDV94hOFU 

3. Richting ‘heading’
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motor driver: zet orders Arduino om in stroom voor motor of ventiel, 
bv. Cytron of IBT_2

stuurmotor: rolt stuurwiel ene of andere kant op

voordelen: zelf bouwbaar, zichtbare werking en eenvoudig ontkoppelen

hydraulisch ventiel: werkt direct in op ‘orbitrol’ en stuurcilinders

voordelen: rechtstreekser werking, netjes

motor/ventiel? advies: begin simpel en hou het veilig
http://gh-ortner.com/agopengps/doku.php?id=steering_motor:start
http://gh-ortner.com/agopengps/doku.php?id=hydraulic_steering:start

Overige componenten
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Begin maar…

(schema 
verouderd)

https://github.com/Coffeetrac/Autosteer_Switch 73

https://github.com/Coffeetrac/Autosteer_Switch
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Autosteer PCB
‘Voorgekookte’ printplaat

Geoptimaliseerde voeding, stabiliteit, …

Aansluitingen aanwezig voor meeste configuraties

Arduino setup volgens eigen situatie

Zelf bouwbaar, ook te koop

momenteel verschillende versies in omloop, bv.:
https://github.com/ropecope/PCB-AutoSteer-AiO
https://github.com/farmerbriantee/AgOpenGPS/tree/master/PCB/AutoSteerPCB_G
erber 75
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tot nu toe werken alle PCB-versies met AOG

PCB v4 op komst, zal hier verschijnen: 
https://github.com/farmerbriantee/AgOpenGPS 

printplaat en componenten online bestellen

solderen is niet moeilijk, met wat ervaring (zie verder)

tips voor zelfbouw, demo filmpjes:
https://agopengps.discourse.group/t/getting-started-with-pcb-hardware-for-beginners/231
https://agopengps.discourse.group/t/tips-and-tricks-on-how-to-assemble-pcb-v2/756
https://agopengps.discourse.group/t/pcb-v2-assembly-video/785 
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PCB zelf solderen (nog geen eigen ervaring)

https://github.com/farmerbriantee/AgOpenGPS
https://agopengps.discourse.group/t/getting-started-with-pcb-hardware-for-beginners/231
https://agopengps.discourse.group/t/tips-and-tricks-on-how-to-assemble-pcb-v2/756
https://agopengps.discourse.group/t/pcb-v2-assembly-video/785


vb.
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Vb. inbouw autosteer 
(Kaupoi mod)
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https://agopengps.discourse.group/t
/kaupoimod-pcb-v2-0/555

https://agopengps.discourse.group/t/kaupoimod-pcb-v2-0/555
https://agopengps.discourse.group/t/kaupoimod-pcb-v2-0/555


PCB-aanbod door Andreas Ortner

https://www.autosteer.cc/shop/

Excel interesse groepsaankoop ?
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https://www.autosteer.cc/shop/
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Overzicht

Tablet met 
AgOpenGPS

Flepos via internet

Smart-
phone 
hot-
spot

antenne op de 
neus v/d tractor

knoppen,
schakelaars

batterij 12V

motor driver

stuurhoek-
sensor
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installeer Arduino IDE: https://www.arduino.cc/en/Main/Software

download map, open AutosteerPCBv2.ino 
https://github.com/farmerbriantee/AgOpenGPS/tree/master/ArduinoCode

pas ‘Setup Zone’ aan naar eigen situatie (zal verdwijnen met v4)

sluit Arduino aan via USB > Hulpmiddelen > Board, Poort checken

Upload (pijl naast vinkje). ‘Uploaden voltooid’, dan OK.

sluit Arduino IDE, start AgOpenGPS. Autostuur poort > COM v/d USB-poort, Connect

goede video hierover: https://www.youtube.com/watch?v=paBm21VlHKI

Setup Arduino
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ter info: COM-poort bij Arduino nano copy’s
installatie driver ‘CH340’ kan even duren, ofwel manueel te installeren. 
COM-poort beschikbaar: dan gelukt.
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Setup Arduino
vanaf v4: instellingen vanuit programma zelf. joepie!

o.a. voor instellen nulpunt stuurhoek zeer welkom
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Setup PCB, modules, connecties
zie slide Anleitung Ortner: =essentieel, rest is bijkomstig

hoort bij deze versie: https://github.com/ropecope/PCB-AutoSteer-AiO
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UIT (motorcontroller) IN (12V van batterij) Schakelaar aan/uit

Hoeksensor

Motorschakelaar (bij stuur)



ter herinnering: AgOpenGPS logica
1. Setup GPS.

Eerste keer starten: GPS-simulator aan (uittesten programma)
Locatie-bron aansluiten, herstart met simulator uit. Pas verder indien GPS

2. Setup stuurhulp.
Voertuig-vehicle
+ Werktuig-implement
+ Perceel-field 
+ AB-lijn. Pas dan functies voor autostuur beschikbaar

3. Autostuur
Arduino voor autostuur aansluiten
Instellingen autostuur doorlopen
Autosteer-knop aanzetten
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instellingen > richting/helling > ‘van autostuur’, stel nulpunt ‘roll zero’ in. herstart

controleer helling (L+, R-) op het vizier
controleer stuurhoek (L-, R+) via instellingen > stuurgrafiek

 pas +/- eventueel aan in arduino setup

autostuur > Stuur : stel in na opbouw hoeksensor op tractor:
nulpunt (voorlopig nog via arduino code) - correcties via slider in AgopenGPS
max stuurhoek (bv. 30°)
aantal per graad: zet wielen op max stuurhoek, lees ‘aantal’ op stuurgrafiek, 
deel door bv. 30°, dit is het aantal, de resolutie per graad

autostuur > Rijden : eerste test voor L/R beweging motor. 
eventueel L/R aanpassen in arduino setup, of contacten ompolen

Setup AgOpenGPS autosteer
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AgOpenGPS autosteer instellingen (1)
Tractor aan, autostuur gekoppeld. Zet stuurgrafiek open om actie-reactie te zien.

autostuur > Gain: varieer P, OG en Min PWM voor goede reactie op correcties van 
stuurhoek in stilstand (belangrijk!) Goede snelle reactie op 1° verschil nodig.

tenslotte > Stanley evt. instellen. Al rijdend testen en eventueel fijner aanpassen

bekijk video om te leren hoe in te stellen:
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AgOpenGPS autosteer instellingen (2)
eens aan het rijden: juiste nulpunt / steer angle zero is belangrijk (drift kan na 
verloop v tijd). niet correct: tractor rijdt dan vaker aan één zijde van de lijn

stabiele stuurhoek-sensor belangrijk: variatie bij stilstand < 0,1° OK. Met PCB 
normaal geen probleem.

≠ machine, snelheid, veldomstandigheden, … hebben eigen ideale set parameters: 
kleine aanpassingen vereist voor hoge precisie

lagere snelheden minder veeleisend, < 5 km/u

‘pursuit’ algoritme inferieur, tenzij zeer lage snelheden?
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Opbouw tractor
op eigen risico

vaak makkelijker op oude tractoren

ga voor (over)capaciteit en veiligheid:

mechaniek stevig, robuust, ontkoppelbaar

elektronica vast, trillingsvrij 
(o.a. voor MMA)

stroomtoevoer en -kabels gedimensioneerd, beschermd, gezekerd  
‘het is maar 12V’ … niet dus. (watt = volt x ampere)
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p-een-ouwe-fiets-moet-je-het-leren/
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https://cards.boomerang.nl/cards/op-een-ouwe-fiets-moet-je-het-leren/


opties:

‘Delphi ER10031’ bv. https://www.amazon.com/Delphi-ER10031-Headlight-Level-Sensor/dp/B0089RT00W 

‘(cadillac) headlight sensor’

‘headlight level sensor’

‘suspension height sensor’ bv. https://www.jansenlarodemontage.nl/epages/62878179.sf/nl_BE/?ObjectPath=/Shops/62878179/Products/lr033256

overzicht: https://agopengps.discourse.group/t/steering-angle-sensors/123  
91

Hoeksensoren

https://www.amazon.com/Delphi-ER10031-Headlight-Level-Sensor/dp/B0089RT00W
https://www.jansenlarodemontage.nl/epages/62878179.sf/nl_BE/?ObjectPath=/Shops/62878179/Products/lr033256
https://agopengps.discourse.group/t/steering-angle-sensors/123


Stuurhoeksensor

http://www.manualsdir.com/manual
s/401128/ag-leader-john-deere-8xx
x-series-wheel-angle-sensor-install
ation.html?page=2
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https://knowledgebase.agleader.co
m/kbp/index.php?View=afile&EntryI
D=2171&AttachID=5143

http://agopengps.gh-ortner.com/dok
u.php?id=pictures:start 93
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aftappen ingebouwde sensor NH
bestaande connecties behouden

0V en signaal (0-5V) identificeren
met multimeter

deze 2 draden naar PCB leiden

in arduino setup 
‘ADS differential mode’
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Stuurmotor

minstens 300 rpm bij 12V (snelle draai kopakker)

kracht: bv. 5 kg.cm (5 Nm), bv. 2A continu met ‘stalled’ piek 10A

bv. Phidgets 3269

bv. Grimson, hoewel laag in rpm: 
https://gimsonrobotics.co.uk/categories/dc-electric-motors/products/gr-ep-52-high-t
orque-planetary-gearmotor-12v-and-24v-versions 

boormachine motor, … ? geluid, levensduur

met 24V motor de keuze: trager 12V of met omvormer 24V voor snel draaien

tips https://agopengps.discourse.group/t/dc-motor-model/784/4 100
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Stuurmotor steun
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https://www.youtube.com/watch?v=
N1OL9TWBWsg
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/dc-motor-model/784/4

http://www.youtube.com/watch?v=dmcU0EYKp9Y
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bv. actuator ompoling dmv 2x
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3D-printen
bv. https://cerea-forum.de/filebase/ 
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https://cerea-forum.de/filebase/
http://www.youtube.com/watch?v=SsN9iDfpMN8


Kabels opbouw tips

12V stroomkabels: 2x 1,5 mm2 minimaal,   opgelet voor lekstroom: schakel + af!
kort, niet bewegend bv. https://www.conrad.be/p/lapp-49900183-draad-liy-z-2-x-150-mm-zwart-per-meter-609312

veiliger voor toevoer/lang: installatiekabel bv. 
https://www.conrad.be/p/lapp-olflex-classic-black-110-stuurkabel-2-x-150-mm-zwart-1120306-50-m-1030356

lage spanning 5V bv.https://www.conrad.be/p/kabeltronik-790202209-schakeldraad-liyv0stliy-2-x-022-mm-zwart-per-meter-486460

zekering: 10-15A
best: aansluiting op gezekerde poort in tractor, minimaal 10A
of rechtstreeks, dan zelf zekeren bv. 

https://www.conrad.be/p/aiv-steekzekeringhouder-auto-platte-zekering-standaard-aantal-polen-1-20-a-25-mm-1-stuks-852863 

datakabels: kort houden, ‘shielded’ om ruis/verstoring te vermijden bv. LIYCY 4x 0,25 mm2
bv. https://www.conrad.be/p/lapp-0034404-datakabel-unitronic-liycy-4-x-025-mm-grijs-50-m-1046099

multimeter kan handig zijn
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Elektronica opbouw tips

micro-schakelaar, tuimelschakelaar, inductieve nabijheidsschakelaar, ...

striptang, kniptang, krimpkousen, soldeer-krimpkousen, vulkanische tape,
kabelmouw, delphi connectors, anderson connectors, AMP connectors, 
dupont jumper, krimpconnectors, krimptang, …

inbouwdozen/behuizing
bv. https://www.conrad.be/p/tru-components-92022c00215-universele-behuizing-115-x-90-x-55-abs-lichtgrijs-1-stuks-1662364

https://www.conrad.be/p/basetech-1310218-gereedschapskoffer-zonder-inhoud-universeel-l-x-b-x-h-240-x-195-x-112-mm-1310218

wartels PG9-PG11, wago lasklemmen, schroefklemmen ‘suikers’, …

dubbelzijdige tape, epoxy-lijm, epoxy-pasta, ... 109

https://www.conrad.be/p/tru-components-92022c00215-universele-behuizing-115-x-90-x-55-abs-lichtgrijs-1-stuks-1662364
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Solderen tips
bv. nodig bij ADS1115, MMA, Cytron MD13S

(uitzonderlijk wel gesoldeerd aangeboden)

soldeerbout: 
kracht toestel belangrijk voor grof werk bv. terminals, relais
toelopende punt voor ook kleiner werk 

soldeertin: beter dunne draad, goed vloeiend (met Pb)

accessoires: laspapier voor propere punt, steun, soldeerhulp, sponsje, ...

tutorials bv. https://www.youtube.com/watch?v=aP_ebVWYzSk 
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Boodschappenlijst autosteer 2019
Essentieel:

Arduino Nano 3-25
ADS1115 1.5-18
Delphi ER10031 10-60
PCB v2 30-100
driver Cytron 13A of 30A 12-35
Phidgets 3269 120-150
kabels, toebehoren 50-100

totaal 300-... euro

Optie/alternatief:

MMA 8452 / 8452Q 1-9
BNO 055 8-35
1/10 rc car rubber wheel 10-?
motorsteun 20-?
12-24V 10A omvormer 10-50
diverse 50-?
...
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Winkels
Phidgets 3269 + ‘NEMA23’ bracket:  Boecker (DE 139+18 eur) / EZtronics (NL 
102+35 eur) (duurste onderdeel)

lokale doe-het-zelf - stroomkabels, verbinders, tape, solderen, ...

Conrad.be - arduino, datakabels, elektronica, inbouwdozen, solderen, ...

Robotshop - arduino, motor driver, modules (BNO, MMA: soms al gesoldeerd), ...

‘vanallesenmeer’ - idem + ADS1115

Digikey, Mouser, ... - onderdelen PCB

AliExpress - diverse gespecialiseerd (<22 euro) 

Rockauto/… - hoeksensor

https://www.boecker-systemelektronik.de/epages/63381271.sf/de_DE/?ObjectPath=/Shops/63381271/Products/11-70-1034
https://www.eztronics.nl/webshop2/catalog/Robotics/robotics-motors?product_id=605
https://www.eztronics.nl/webshop2/catalog/index.php?route=product/product&product_id=542

bv. loopwiel voor motor-as 12mm via AE:

RC schuimwielen hex https://nl.aliexpress.com/item/32832334912.html?spm=a2g0s.9042311.0.0.720e4c4dvtIRSj 
hex koppeling buitendiam. 11 mm https://nl.aliexpress.com/item/32794944304.html?spm=a2g0s.9042311.0.0.27424c4d9fQa9R
askoppeling 12-12 mm https://nl.aliexpress.com/item/32835373585.html?spm=a2g0s.9042311.0.0.27424c4d9fQa9R 
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sensor ttps://www.rockauto.com/en/catalog/cadil-lac,2009,cts,3.6l+v6,1442758,suspension,ride+height+sensor,17137
connector https://www.aliexpress.com/item/4000022830975.html?spm=a2g0o.productlist.0.0.3f159807Sultk6

https://www.boecker-systemelektronik.de/epages/63381271.sf/de_DE/?ObjectPath=/Shops/63381271/Products/11-70-1034
https://www.eztronics.nl/webshop2/catalog/Robotics/robotics-motors?product_id=605
https://www.eztronics.nl/webshop2/catalog/index.php?route=product/product&product_id=542
https://nl.aliexpress.com/item/32832334912.html?spm=a2g0s.9042311.0.0.720e4c4dvtIRSj
https://nl.aliexpress.com/item/32794944304.html?spm=a2g0s.9042311.0.0.27424c4d9fQa9R
https://nl.aliexpress.com/item/32835373585.html?spm=a2g0s.9042311.0.0.27424c4d9fQa9R
https://www.rockauto.com/en/catalog/cadil-lac,2009,cts,3.6l+v6,1442758,suspension,ride+height+sensor,17137
https://www.aliexpress.com/item/4000022830975.html?spm=a2g0o.productlist.0.0.3f159807Sultk6


Accessoires, uitbreidingen
Communicatie Arduino draadloos of via ethernet ipv USB

bv. bluetooth module
https://www.ardusimple.com/product/bluetooth-module/ (zelf geen ervaring mee)
ruwe HC-05 module: nog in te stellen baud rate, zie slide

bv. UDP/ethernet (nog geen documentatie) 
https://agopengps.discourse.group/t/ethernet-setup-help/585 

‘dakmodule’ obv ESP32 met dual gps antenna, in ontwikkeling
https://github.com/mtz8302/AOG_Dual_GPS

aansturing cabine via relays, actuators, ... (eigen risico, opgelet) 113
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bv. voor de moedigen: HC-05 module instellen

HC-05
Baud rate veranderen:
maak connecties met een (nieuwe) arduino nano zoals aangegeven hier: 
https://www.instructables.com/id/Change-the-Baud-Rate-of-HC-05-Bluetooth-Module-Usi/
Indien een nano met al een sketch op, upload lege sketch:

void setup() {}
void loop() {}

sluit de nano via usb aan, terwijl op de HC05 de button inhouden om in AT mode te gaan
de COM-poort van de arduino vind je bij apparaatbeheer ergens als bv. USB-SERIAL CH340
open Termite in Windows, met bv. COM10 38400bps (38400 is de baud rate van AT mode!)
de gewone AT-commands werken. bv. AT+UART=115200 (voor simplertk2b) of 38400 (arduino)

Connectie met arduino/simpleRTK2B/…: TX en RX kruisen + ‘voltage divider’ nodig om van 5V naar 3,3V niveau te gaan (PCB!)
Zelfde baud rate instellen in HC05, aangesloten arduino/... en AgOpenGPS.
COM-poort is maar door 1 programma tegelijk bruikbaar (sluit Arduino IDE/Termite/… om in Agopengps te koppelen)
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Wat brengt de toekomst?
AgOpenGPS:

binnenkort met v4 grote wijzigingen (wrs andere .ino voor arduino uploaden)
mogelijk switch naar andere processormodule (ESP32/…)
allen naar dual antenna GPS in 2020?
houdbaarheidsdatum huidige hardware ??

Serieuze alternatieven met (open source) lage-kost systemen, plug&play

Standaarden, compatibiliteit tussen systemen oiv open source

Omwenteling van huidige, weinig concurrentiële markt

...
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Contact ivm AgOpenGPS
nederlandstalige gebruikersgroep AgOpenGPS:
https://t.me/agopengpsgebruikers (Telegram installeren op pc/smartphone/…)

ontwikkeling, discussie (engelstalig):
https://agopengps.discourse.group
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